
INTRODUCTION

This Software is a breakthrough product with tremendous educational and entertainment 
applications.

FOR YOUR OWN ENJOYMENT:  
Playing the piano or any other keyboard instrument requires extraordinary coordination of 
mind and body. Arms, hands, fingers, and feet must work in perfect cooperation with the 
ears, eyes, and brain. To attain these physical skills, keyboard virtuosos dedicate their 
lives to a ceaseless regimen of practice. The rest of us who love music and feel a desire 
to play it, can't or won't spend our time in such a regimen. 

So for us, the physical skills remain a formidable barrier to keyboard playing. The  
Software allows you to create rhythmically expressive real-time musical performances 
without spending years of practice developing physical skills.

The Software removes the necessity of recalling which notes are to sound and where 
your hands must move to make them sound. This leaves you free to focus your attention 
on rhythm and expression. Each time you strike a key on your computer or MIDI 
keyboard, the MIDI software simultaneously triggers one or more stored note events 
while you enjoy powerful, expressive real-time rhythmic control.

You can order additional songs from our extensive inventory. With the Software, you can 
enjoy playing a lifetime's worth of your favorite music; it will sound the way you feel. 

FOR MUSIC EDUCATION:    
The Software can be used either as a supplement or an alternative to traditional music 
teaching. In traditional music teaching, students normally develop substantial technical 
skills before experiencing expressive music making. These requisite technical skills are of 
a broad range, including note and rhythm reading, pitch recognition, and the very 
substantial physical skills necessary to manipulate musical instruments or the voice. 

The Software separates the technical skills from the expressive skills in music making. 
This allows the student to concentrate on the expressive skills while the technology takes 
care of the technical skills.

With the help of the Software, most students will be able to experience the joys of 
expressive music playing on a regular and continuing basis. They can experience the 
emotional, artistic, intellectual, and creative challenges which give beauty, personality 
and meaning to an otherwise lifeless piece of printed music.

The Software is especially useful in teaching rhythmic skills as a supplement to traditional 
music teaching. The student can concentrate on playing the proper rhythm without having 
to simultaneously worry about the correct pitches.

The Software is perfect for the music appreciation student who does not participate in 
instrumental or vocal ensembles. Normally these students will not be involved in music 
performance. The Software gives them an unexpected opportunity to experience live, 
expressive music playing.

The Software takes the performance gestures of expressive keyboard playing and distills 
them to their simplest essence. This is achieved by assigning some tasks to the 
computer that otherwise would have been the responsibility of the performer. The 
Software separates music note reading and finger and hand placement from the 
expressive gestures of timing and touch. The technology removes the necessity of 
recalling which notes are to sound and where your hands must move to make them 



sound. This leaves students free to focus their attention on musical expression. On each 
keystroke, the Software simultaneously triggers one or more stored note events from the 
keyboard while you enjoy powerful, expressive real-time control over the sound.

Although the Software is, in many ways, a completely new kind of musical instrument, all 
of the cognitive skills of standard keyboard playing can be transferred intuitively to its 
performance. When used by itself, the Software will bring the experience of highly 
expressive keyboard performance to people who have limited or no technical proficiency. 
When used with MIDI sequencing software, it becomes a musical tool of virtually 
unlimited educational and professional value. 

To use the Software you need the following:
• An IBM PC or compatible with a 386 (minimum) microprocessor and 
Microsoft Windows version 3.1 or greater, running in standard or enhanced mode 
• Hard disk drive with at least 1.4MB of available storage
• An internally installed Windows 3.1 compatible MIDI sound card, or an 
external MIDI sound system

This manual assumes that you have read and are familiar with the owner's guides that 
came with your computer. You should know how to use the mouse, open applications and 
documents, and use Windowsr . 

SONG FOLDERS

The seventeen Multiple Arrangement Song Folders packaged with the Software have 
been specifically designed for educational and entertainment applications, and are a key 
feature of the Software. 

A Multiple Arrangement Song Folder consists of two or three Music File folders. The 
Music File folders correspond to different arrangements of the song which have separate 
educational applications. The song arrangements are classified into Type 1, Type 2, and 
Type 3.

Type 1 arrangements are the easiest to perform with the Software and are ideal for the 
musical development of very young children and the musically inexperienced. These 
arrangements are based on a completely regular rhythm, so that a rhythmically correct 
performance can be made simply by applying a steady beat with one finger on one key. 
The corresponding Rhythm files will have regularly spaced icons. The corresponding 
Note files will use icons for notes and rests from regular music notation. 

In Type 2 arrangements, the rhythm corresponds exactly to the melodic line. These 
arrangements are more difficult to perform since the rhythm is not completely regular. The 
performance of Type 2 arrangements represents an important and natural step in musical 
development. The corresponding Rhythm files reflect the additional rhythmic complexity 
with their proportionally spaced symbols. 

Most of the Type 2 arrangements have Lyric and Reading files. The Lyric files show the 
words to the song placed below notes and rests from regular music notation.

The Reading files associated with most Type 2 arrangements are a special feature of the 
Software. Reading files allow young readers to practice and expand their reading skills in 
a musical environment. This use of the Software for young readers does not depend on 
rhythmically precise performance.

Type 3 arrangements correspond to the way the song is most often performed and heard. 
Unlike Type 1 arrangements, the rhythm is not completely regular. And unlike Type 2 



arrangements, there will be passing notes and chords. Students who have mastered the 
performance of Type 1 and Type 2 arrangements should be able to move on to the Type 
3 arrangements.

Single Arrangement Song Folders are also available from the Company, and are based 
on only one of the three Types. Certain classical piano pieces, accompaniments to 
songs, and instrumental solos do not lend themselves well to multiple arrangements. 

When opening a score file from the File Menu, you can tell whether the score is of type 1, 
2, or 3 by looking at the suffix. All score files ending in .Ss1 or .Sm1 are of type 1.  All 
score files ending in .Ss2 or .Sm2 are of type 2. And all score files ending in .Ss3 or .Sm3 
are of type 3.

The first 's' indicates that the file is a score file. The 's' or 'm' in the second position 
indicate whether the score file is single channel or multi channel. Single channel score 
files are intended to be performed with a single instrument such as a piano arrangement. 
Multi channel score files are intended to be performed with several instruments such as a 
band, orchestra, or ensemble. Four of the Song Folders contain multi channel 
arrangements as well as single channel arrangements.

INSTALLATION

If you will be using the Software with a MIDI sound system, we recommend that you set 
up your MIDI system before installing the Software. Refer to your owner's manual for 
proper hardware and software installation and setup of your MIDI interface. After this is 
completed, shut down your computer. Connect your MIDI interface to a serial port or 
game port on the back of your computer with the cable designed for this purpose that 
was packaged with the MIDI interface. Then connect the MIDI in from the MIDI interface 
to the MIDI out on your MIDI keyboard or tone generator with a MIDI cable. Also connect 
the MIDI out from the MIDI interface to the MIDI in on your MIDI keyboard or tone 
generator with a second MIDI cable. Make sure that your keyboard is transmitting on 
channel 1. You are now ready to install the Software. At this time, you should make a 
backup copy of the Software on a floppy disk.

Preparing For Font Installation
Before beginning the installation procedure, make sure that all fonts, not just True Type 
fonts will be shown in applications. To check this, do the following:

Run Windows as you normally would. From the Program Manager, double click on the 
Main icon. From the Main Window, double click on the Control Panel icon. Double click 
on the Font icon and then click on the True Type... button in the Font window. When the 
True Type Window opens, make sure that the box to the right of "Show Only True Type 
Fonts in Applications" is not checked. If it is, click on the box to uncheck the box. 

When the box is empty (unchecked), click on OK in the True Type Window. Then click on 
cancel in the Font Window and close the Control Panel window. 

Software Installation
To install the software do the following:

1.  Insert your Instant Pleasure Program Diskette (Instant Keyboard for the 
educational edition) into an available floppy drive. (We will assume it is drive A.) 

2.  From the Program Manager, select Run from the File menu. In the Command 
Line box type: 



A:\install

3. When the Instant Pleasure-Installation window appears, (Instant Keyboard for the 
educational edition), click on the Full Install button. The Installation program will ask if you 
wish to create Windows icons for the application. If you wish to place the icons in a group 
different from the one suggested, select it now. If you wish to create a new group in which 
to place the icons, type the new name now. Finally, click on the Create button.

4.  When the Installation is complete, click on the OK button.

You have copied all directories and files from your Program Diskette into the directory 
named INSPLEAS in the WINDOWS directory on your C drive (INSKEY) for the 
educational edition). You have also installed the Software's required fonts and set up the 
application and its icons for use in the Windows Program Manager. 

To run the Software, double click on its icon in the appropriate group window in the 
Program Manager. 

If you received an error message regarding Font installation, you probably did not follow 
the instructions contained in the Preparing For Font Installation section above. At this 
time you should read the section, follow its instructions and repeat the installation 
procedure.

Congratulations! You have successfully installed the Software. You are ready to proceed 
to the Tutorial. We recommend that you complete the Tutorial before reading the main 
body of the manual.

TUTORIAL

Once you have successfully installed the Software, you are ready to open your first 
Score. This Tutorial will guide you through the process of opening, listening to, 
performing, and closing Scores, as well as introduce you to the many useful features of 
the Software. This Tutorial is designed to help you get started with the Software; it is not 
meant to be an in-depth explanation of the application's many functions. The remainder 
of the manual is devoted to a discussion of all of the Software's functions and features, 
as well as suggestions for creative and educational uses.

To open a score file do the following:

If you are viewing the splashscreen, click on the Ok button. The Open Score dialog box 
will appear. The directory will show the song folders that sit in your INSPLEAS (INSKEY) 
folder on your C Drive.

If you are not viewing the splashscreen, pull down the File Menu, and click on Open 
Score. The Open Score dialog box will appear. Find the Instant folder on your C Drive 
and double click. The directory will then show the song folders that sit in your INSPLEAS 
(INSKEY) folder on your C Drive. 

Scroll down in the Directories Window until the folder titled oldflag appears. Double click 
on the oldflag folder. Three folders will appear. Double click on the oldflag.s1 folder. You 
will see the "You're A Grand Old Flag" score file (oldflag.Ss1) appear in the left file 
window. Open it by double clicking on it. The Control Window will appear. 

NOTE:
If you will be using a MIDI keyboard or other external controller as an input device, you 
should pull down the Options Menu and click on MIDI Input Settings.... Select the 



appropriate driver by clicking. If you do not have a MIDI keyboard, or if you plan to trigger 
the Software only from the computer keyboard, you may skip this step.

In the Software, Type 1 Song files are always based on completely regular rhythms. 
These are most suitable for introducing very young children to performing music with the 
Software. Very young children generally have difficulties reproducing variable rhythms.

Check your MIDI keyboard to be sure that it is receiving and sending MIDI on channel 1. 
(If you're not sure how to do this, check your keyboard's manual.)  Make sure that the 
MIDI out from your serial interface is connected to the MIDI in of your keyboard, and that 
the MIDI in of your interface is connected to the MIDI out of your keyboard.

Pull down the Options Menu, and click on Channel Assignments.... The Channel 
Assignments Dialog Box will appear. 

You will notice that "Single Channel Score File" appears in the upper right hand corner of 
the dialog box. This indicates that the score file has been constructed with a single 
instrument sound in mind. You can also tell this from the 's' in the suffix of the score file 
name. 

Notice that 'M/A' appears under Set in the row for channel 1. Also notice that 'Off' 
appears under Set in the rows for channels 2 - 16. This means that both the Melody and 
the Accompaniment parts will sound on channel 1, and no notes will sound on the other 
channels. This is the default setting. However, the program allows you the flexibility of 
controlling which channels are used for melody and which channels are used for 
accompaniment by clicking on the appropriate boxes under Set. An 'M' indicates melody 
only; an 'A' indicates accompaniment only; 'Off' means neither; and 'M/A' indicates both 
melody and accompaniment (i.e., all notes). We recommend that you choose channel 
one for melody and channel one for accompaniment by leaving 'M/A' under Set for 
channel 1. 

NOTE: 
If you do not know which channel or channels your MIDI system is set to receive, please 
refer to the manual which came with your keyboard or tone generator.
NOTE:
If "Multi Channel Score File" appears in the upper right hand corner of the dialog box, 
then this indicates that the score file has been constructed with several instrument 
sounds in mind.  In this case, the boxes under Set will only toggle between 'Off ' and 'M' 
or 'Off' and 'A'.  

Instrument sounds can be selected by clicking on the box in the Voice column next to the 
appropriate MIDI channel number, dragging to the desired instrument name and 
releasing. This sends out a MIDI program change message on the appropriate channel. 
Since channel and instrument assignments are saved to the score, the program change 
for the instrument listed on any channel whose melody or accompaniment box is checked 
was sent upon opening the score.

NOTE: 
The instrument names displayed in the dialog box conform to those recommended in the 
General MIDI Specification. If your MIDI device does not support General MIDI patch 
names, the particular program names displayed in the Software may not match those on 
your MIDI device. In this case, you should use the program change numbers (1-128) 
displayed with the names as a reference for selecting particular sounds or "patches" on 
your MIDI device.

The additional columns titled Vol, Pan, and Trans, provide added flexibility. Vol controls 



the volume of sound coming out on the associated channel. These are used to set the 
relative balance between instrument sounds. Pan controls the panorama of sound 
coming out on the associated channel. And Trans allows you to separately transpose the 
output of each channel. These settings are useful for adjusting the multitimbral balance. 
We recommend that these settings are kept at neutral, which is the default.

After these settings are made, the dialog box should look like this:

Close this dialog box by clicking the close button. You have now ensured that channel 1 
will be used exclusively for the sound output of both the melody and accompaniment 
notes, and the remaining settings are the neutral default. The Control Window will now 
reappear.

Click on the arrow icon in the box above Listen. If all of your settings and connections are 
correct you will hear a rather unexpressive rendition of You're A Grand Old Flag. Listen to 
the entire song and notice that the Stop button is automatically highlighted when the song 
ends.

NOTE:
If you do not hear any sound when you click on Listen, check your MIDI and audio 
connections. Strike a note on your keyboard to make sure that it is properly connected. If 
your keyboard sounds when you strike a key but does not sound when clicking Listen, 
check the MIDI settings on your keyboard as well as the section on Instruments/Channel 
Assignments... under the Options menu. Also, check the MIDI Input Settings and MIDI 
Output Settings under the Options menu to be sure you have selected the proper drivers. 
If you have selected the MIDI mapper as the output device, quit the software at this time 
and open the MIDI mapper and make sure that  your keyboard, tone generator or sound 
card is mapped to the channel(s) you have selected in the Instruments/Channel 
Assignments dialog box. Then run the software as before.

After you have listened to the song, try clicking on the Listen button again. This time, click 
the Pause button at any point during the song. The playback will immediately cease. 
Clicking on the Listen button will restart the song from the point at which playback 
ceased. 

When the song ends and the Stop button is once again highlighted, look at the four 
control faders labeled Tempo, Key, Melody Volume, and Accompaniment Volume in the 
Control Window. To control these faders, either click on the arrows on either side of the 
fader, or click on the shaded area on either side of the fader, or click and drag the box in 
the direction of either arrow. Experiment with changing the speed, pitch, and volume 
balance of the song by changing the fader values while playing the song in the Listen 
mode. Repeat the Listen command until you are familiar with the manipulation and 
function of the Control Window faders. Please note that the Melody Volume and 
Accompaniment Volume faders will only be effective if your MIDI keyboard or tone 
generator responds to MIDI velocity data. Failure to respond to MIDI velocity data is a 
limitation of certain MIDI keyboards and tone generators, not of the Software.

After the song has finished and the Stop button is highlighted, click on the exclamation 
point icon which is in the box above Perform. This tells the Software that you will be 
performing the song from either your MIDI keyboard or your computer keyboard. Using 
one finger to strike one key, tap out the steady rhythm of You're A Grand Old Flag.Ss1 on 
any appropriate key on your keyboard. (If you are using a computer keyboard, choose a 
small key in the second or third row; see the section Performing From The Computer 
Keyboard.) 

If you are using a MIDI keyboard, avoid the four highest and four lowest keys; see the 



section on the Perform menu for information about MIDI keyboard settings.) You will hear 
the song played according to your rhythm. If you strike the key one time for each note of 
the song, you will soon be able to perform an expressive rendition of You're A Grand Old 
Flag.Ss1.

The song will repeat over and over so you can practice as many times as you wish. Try 
different tempos by striking the key in rapid or leisurely succession. If you're performing 
from a MIDI keyboard, try playing the song louder and softer by striking harder or more 
gently on the key. You are now doing many of the things a skilled piano player does when 
he or she is expressively interpreting a piece of music.

NOTE:
If you hear the note you are striking on the MIDI keyboard along with the notes to You're 
A Grand Old Flag, see the Options menu section and read the information regarding 
Local Control On and Local Control Off under the Options menu. If you hear the note you 
are striking, and no other notes, then the Perform Scores From MIDI under the Options 
menu is probably not checked. If striking a key harder or more gently on your MIDI 
keyboard does not affect the volume of the notes, it is probably because your MIDI 
keyboard is not touch sensitive. We recommend that you make sure Perform Scores 
From MIDI remains checked for the remainder of the Tutorial.

When you release the key after the last note of You're A Grand Old Flag.Ss1, the notes 
will stop sounding, just as they would in a standard performance. Please note that if you 
release a key at any time in the middle of the song, the notes that are sounding will be 
sustained until you either strike another key or click the Stop or Pause button. This is 
because the Software is set to perform in the Automatic Legato mode. (Legato is an 
Italian word used by musicians to mean "connected.") While in Automatic Legato mode, 
all of the notes in the song (except at the very end) will sound until you strike a key again, 
regardless of when you release the key. This creates a pleasant musical effect. If you 
want to control the releases of notes as well as their beginnings and volumes you need to 
change the Software to the Controlled Legato mode. To change it, click on the word 
Automatic in the box next to the word Legato, release, and click on the word Controlled 
and release. The Control Window should now look like this:

Now, click on the Perform icon and once again strike the keys to the rhythm of You're A 
Grand Old Flag.Ss1. As you perform, release the key and wait a moment before 
restriking it; you will notice that a bit of silence or "space" will be placed between the 
notes. Performing a song with space between the notes is called Staccato. If you perform 
the melody by alternating between two different fingers striking two different keys, a 
variety of Legato and Staccato effects can be achieved in the same performance. When 
you have finished experimenting with Legato and Staccato effects, click the Stop button. 
You may also wish to switch back to Automatic Legato by clicking on the word Controlled 
in the box next to the word Legato, releasing, and clicking on the word Automatic. 

To achieve separate volume control over the melody and the accompaniment while 
performing from your keyboard, you need to set the Software to the Controlled Chords 
mode. To do that, click on the word Automatic in the box beside the word Chords, 
release, and click on Controlled. Assuming that you switched back to Automatic Legato, 
the Control Window should look like this:

Your MIDI keyboard will now be divided into two regions: the upper region which includes 
all keys at or above "middle C" and the lower region which includes all keys below middle 
C. Your computer keyboard will be similarly divided: the upper region includes all small 
keys in the first two rows (the rows furthest away from you); the lower region covers all 
small keys in the last two rows.



A keystroke in the upper region while performing the song in the Controlled Chords mode 
causes the Software to trigger all notes for the chord at the current position. The Software 
determines the sound volume level of the melody notes from the velocity of the upper 
region keystrokes. A keystroke in the lower region at approximately the same time will 
determine the sound volume level of all of the accompaniment notes. If no keystroke in 
the lower region occurs at around the same time, then the sound volume level of the 
accompaniment notes is determined by the last prior keystroke in the lower region; if 
there was no prior keystroke in the lower region, then by default, the Accompaniment 
Volume fader setting on the Control Window is used.

NOTE:
If you select the Perform mode and strike keys at or above middle C, or computer keys 
only in the first two rows, the accompaniment notes will sound at the default volume 
selected by the Accompaniment Volume control fader on the Control Window. You 
successively strike the keys at or above middle C to play the notes of the song. For 
additional information, see the section called Performance Tips.

You may of course choose both Controlled Legato and Controlled Chords simultaneously, 
in which case Controlled will appear to the right of both Chords: and Legato: on the 
Control Window.

The Software also features two exciting additional chord modes called divided chords 
and independent chords. These modes give you added control over the MIDI velocities of 
accompaniment and melody notes and their relative timing. The melody and 
accompaniment parts are still linked so that the parts remain in synch.

The Software features useful graphics. The Graphic Display at the bottom half of the 
Control Window displays Rhythm files, Note files, Lyric files, and Reading files. 

To display Rhythm files, simply press on the Rhythm button and release. By pressing the 
Rhythm button you will toggle between the regular sized Rhythm files and the double 
sized Rhythm files. The regular size has the advantage that you can see more of the file 
at once, and the double size has the advantage of being larger and easier to read. The 
Control Window should now look like this:

Once the Rhythm file appears on the Graphic Display, click on Listen or Perform and 
watch the Software highlight the region from the appropriate line segment (indicating the 
chord that is sounding) to the next line segment. You can click on any of these line 
segments in order to start at any desired position. 

Rhythm files are based on proportional spacing. This is very different from regular music 
notation, and is designed especially for beginners. The numbers in the Rhythm files 
indicate the beginning of measures. The triangles indicate the placement of beats 
according to the time signature of the score. The vertical line segments indicate the 
proportional placement of chords. A line segment above the horizontal base line indicates 
a chord with only melody notes. A line segment below the horizontal base line indicates a 
chord with only accompaniment notes. And a line segment that goes below and above 
the horizontal base line indicates a chord which has both melody and accompaniment 
notes. This melody and accompaniment information is useful in helping the performer 
know what is to be emphasized in the performance. 
   

To display Note files, simply press on the Note button and release. By pressing the Note 
button you will toggle between the Single Note files and the Dual Note files. The Single 
Note files display a single musical line with regular music notation, except that there is no 
staff line indicating pitches. For the beginner, this bridges some of the gap between the 



proportionally spaced Rhythm files and regular music notation. The Dual Note files 
display the melody and accompaniment on separate lines, and represents an additional 
step towards regular music notation for beginners. 

Once the Note file appears on the Graphic Display, click on Listen or Perform and watch 
the Software highlight the appropriate notes. You can click on any of the note icons in the 
Single Note files in order to start at any position. In Dual Note files, click on any asterisk 
in order to start at the desired position.

To display Lyric files, simply press on the Lyric button and release. By pressing the Lyric 
button you will see a Single Note file with lyrics added.

Once the Lyric file appears on the Graphic Display, click on Listen or Perform and watch 
the Software highlight the appropriate syllables. Asterisks are used to indicate the 
presence of a note or chord without a corresponding lyric. You can click on any syllable or 
asterisk in order to start at a desired position.

Reading files are specially designed for young readers. Reading files are included with 
Type 2 files only. To open Type 2, first close You're A Grand Old Flag.Ss1 by clicking on 
the upper left hand corner of the Control Window. (You can answer the dialog as you 
wish). Now open You're A Grand Old Flag.Ss2 by the path --
C:/INSPLEAS/oldflag/oldflag.s2/oldflag.Ss2.

The rhythms of Type 2 files follow the melody of the song in a one for one fashion. As you 
perform You're A Grand Old Flag.Ss2, notice how each key press corresponds to a 
syllable in the lyrics.

To display the Reading file for You're A Grand Old Flag.Ss2, press on the Reading button 
and release. When the Reading file appears on the Graphic Display, click on Listen or 
Perform and watch the Software use highlighting and underlining of syllables at the 
appropriate times. Syllables that have just been triggered are highlighted, and syllables 
that are next to be triggered are underlined. You can click on any word in order to start at 
a desired position. 

You're A Grand Old Flag.Ss3 has the most sophisticated rhythm. Type 3 files make free 
use of passing chords and variable rhythms. 

The Graphic Display can be closed by choosing Close from the Graphic Display menu 
located in the upper left hand corner of the window. It can also be resized by clicking on 
the little triangle in the upper right hand corner of the Graphic Display Window.

You have now learned the basic functions of the software. You can repeat this entire 
Tutorial trying as many scores as you desire. When you wish to quit the application, press 
on the File menu, drag to Quit, and release. We hope you will read the remainder of the 
Manual, and become fully acquainted with the features of the Software.


